
Oracle Financial Services 
Asset Liability Management Analytics 

 
Product Installation Manual 

Version 6.2.0.0.0 
August 2014 

 



 
Document Control 
Author: Niraj Ranjan Biswal Group: OFSAA  
Created on : 14th August 2014 Revision No : 6.2.0.0.0  
Updated by : Asma Anjum Revised by: Syed Hussain Approved by: 
Updated on : 14th August 2014 Revised on : 14th August 2014 Approved on: 14th August 

2014 



Installation Manual 

Table of Contents 
About this Manual ........................................................................................................................ 1 

Audience ...................................................................................................................................... 1 

Scope ........................................................................................................................................... 1 

Organization of the Manual ......................................................................................................... 1 

Conventions Used in this Manual ................................................................................................ 1 

Prerequisites ................................................................................................................................ 2 

Environment ................................................................................................................................. 2 

Prerequisites ................................................................................................................................ 2 

Front-End Access ........................................................................................................................ 2 

Installing Oracle Financial Services Asset Liability Management Analytics 6.2.0.0.0 ................. 3 

Pre-Installation Activities ............................................................................................................. 3 

Oracle Financial Services Asset Liability Management Analytics v6.2.0.0.0 Product 
Installation .................................................................................................................................... 4 

Machine A – Product App Layer .................................................................................................. 5 

Machine B – Product Database Layer ....................................................................................... 17 

Silent Installation........................................................................................................................ 22 

How to Install ALMBI in Silent Mode ......................................................................................... 22 

Post Installation Activities .......................................................................................................... 26 

Oracle Financial Services Analytical Applications Infrastructure Server Memory Configuration26 

Oracle Financial Services Asset Liability Management Analytics Configuration ...................... 27 

Trouble shooting ........................................................................................................................ 34 

 

 

 



 

About this Manual 
The Oracle Financial Services Asset Liability Management Analytics (OFSALMA or ALMBI) 
application release 6.2.0.0.0 is based upon a dedicated reporting mart built from the new 
Fusion Financial Services Data Model. OFSALMA 6.2.0.0.0 leverages several components of 
Oracle Business Intelligence Enterprise Edition (OBIEE) technology including Dashboards 
and Answers. It also includes various Dashboards and Reports for the user to carryout 
various Liquidity Gap based analytics. 

Audience 

This Manual is meant to be used by the Oracle Financial Services Analytical Applications 
Infrastructure (OFSAAI) System Administrator. This provides step-by-step instructions 
necessary for installing the OFSALMA release 6.2.0.0.0. 

Scope 

This manual provides a step-wise instruction to install the OFSALMA in an existing OFSAAI, 
hosted in Oracle 11g R2 (11.2.0.3.0) environment. 

Organization of the Manual 

The Installation Manual is organized into the following chapters. 

• Prerequisites section identifies the hardware and base software environment 
required for successful installation and functioning of OFSAAI. 

• Installing Oracle Financial Services Asset Liability Management Analytics 
6.2.0.0.0 section details the pre-installation activities followed by a step-by-step 
instruction on the various installation options. 

• Post Installation Activities section details the steps that are required to be 
performed after a successful installation of OFSAAI. 

Conventions Used in this Manual 

References to sections or chapters in the manual are displayed in Italics. 

Screen names are displayed in the following manner: 

Introduction screen 

Options and buttons are displayed in Bold. 

Notes are displayed as follows: 

Note 

o It is important that the password should be 6 characters long. If you do not 
adhere to this pre-requisite, you will see a system message that reads Password 
must be at least 6 characters long. 
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Prerequisites 
The installation process requires certain environmental variables to be set prior to starting the 
installation. You must ensure that these requirements are met before starting the installation. 
Refer to the Release Notes for the latest updates on hardware or software requirements and 
the OFSAAI Installation Manual for the environment variables. 

Environment 

Installation of OFSALMA release 6.2.0.0.0 requires OFSAAI v7.3.5.0.0, which is certified on 
Oracle 11g R2 (11.2.0.3.0) to be installed in either a single-tier or multi-tier environment. It is 
implicit that all base software versions and patch levels required by the OEL-5.5 version of 
OFSAAI v7.3.5.0.0 are available and adhered to. 

Prerequisites 

• Oracle Financial Services Analytical Applications Infrastructure version v7.3.5.0.0. 

• Oracle Financial Services Liquidity Risk Management 3.0.0.0.0 

• Oracle Business Intelligence Enterprise Edition version 11.1.1.7.0 on any supported 
operating system, once installed must be configured. 

• After Installation of OBIEE 11.1.1.7.0, following patch is recommended for all the 
customers who are using Oracle Business Intelligence Enterprise Edition 11.1.1.7.0, 
which can be downloaded from Oracle support site. 

• 16556157 

Front-End Access 

• Internet Explorer 8.0/9.0 

• Java Plug-in 1.6.0_21 

• Acrobat Reader 8.0 

• The screen resolutions supported are 1024*768 and 1280*1024 

Note 

o Ensure that Java Plug-in is enabled from Browser Settings. 
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Installing Oracle Financial Services Asset Liability 
Management Analytics 6.2.0.0.0 
Pre-Installation Activities 

The following is the Pre Installation checklist to ensure the readiness to start installing 
Oracle Financial Services Asset Liability Management Analytics Product: 

• Oracle Financial Services Analytical Applications Infrastructure v7.3.5.0.0 must be 
successfully installed. 

• If Infrastructure installation is on multi-tier environment, execute the following 
command in the DB Layer terminal  

• chmod -R 777 < ftpshare folder > 

• Navigate to ftpshare folder and set the umask shown as below, this is to ensure all 
the new files created have 666 file permissions assigned. 

• cd < ftpshare folder >  

• umask 0000 

• The Config and Atomic schema should be two distinct Oracle database users. 

• Provide required privileges for atomic schema by executing the file 
privileges_atomic_user.sql from DBA user. 

• Copy the entire OFSALMA v6.2.0.0.0 installer download directory to the server 
location (Including the DataModel directory). Also provide read, write, and execute 
permissions to all the files present in this directory. 

• Specify the log file path and name in the log4j.xml. Also update the “value” attribute 
as mentioned in the following figure. 

 
Figure 1: Log4j.xml file configuration 

• Ensure that the paths mentioned in log4j.xml file have read, write, and execute 
permissions set. 

• Navigate to $FIC_HOME directory and execute the script 
config_table_privileges_for_atomic_user.sql in configuration schema. 

• Ensure that FICServer is up and running before proceeding for installation. 

 

3 
 



 

Oracle Financial Services Asset Liability 
Management Analytics v6.2.0.0.0 Product 
Installation 
The Oracle Financial Services Analytical Applications Infrastructure Product comprises of 
components that are installed in Web, Application, and Database layer. Hence if you have 
installed OFSAAI 7.3.5.0.0 in a multi-tier architecture, the OFSALMA product installer must be 
invoked on each of the machines that host OFSAAI tiers. 

For a Single-tier installation, the installer is required to be invoked only once on the machine 
that hosts all the OFSAAI tiers. 

This section describes the installation process where the three product setup components are 
installed on separate machines in with the product installation on separate machines. 
Machine A is used to install product Application Layer components, Machine B is used to 
install product Database Layer components and Machine C is used to install product Web 
Layer components.  

NOTE 

• This section is applicable only if OFSAAI v7.3.5.0.0 has been installed separate 
machines A and B respectively. 

• Refer to section on Silent Installation, if you wish to install the application in silent 
mode. 
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Machine A – Product App Layer 

Step 1 

To begin Oracle Financial Services Asset Liability Management Analytics product installation, 
execute the file Setup.sh. 

 
Figure 2: Installation Splash Screen 

Step 2 

 
Figure 3: Introduction Screen 

Upon invoking the installer, the Introduction screen is displayed with the prerequisites for 
installation. Ensure that all the prerequisites are met before you proceed with the installation. 

Step 3 

Choose the log mode for this installer. If Debug is selected, the Passwords will be printed in 
the log file. 
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Figure 4: Log Mode Option Screen 

Step 4 

Provide the 9 digit Customer Identification Number provided during the OFSAAI installation. 

 
Figure 5: Customer ID Input Screen 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine. 

For example, Application Layer 

 
Figure 6: Pre Setup Information Screen – Choose Layer to Install 

Along with appropriate OFSAAI layer choose Administrative Reports to configure the 
Administrative Reports application. 

NOTE 

o For a single-tier OFSAAI installation, you must select App Layer, DB Layer, and 
Web layer. For a multi-tier OFSAAI installation, select the corresponding layer 
installed on the machine. 

o Incase Admin BI is already configured through the previous product installation; 
the subsequent product installation without Admin BI option may alter the existing 
Admin BI configuration settings. 
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Step 6 

This window seeks information on whether a new infodom has to be created or the existing 
infodom is to be used for apps installation. Select the desired option. 

 
Figure 7: Pre Setup Information Screen – Infodom type 

Click Next to continue. 

Step 7-i 

If the option New Infodom was chosen in the previous window, then the following window 
with create Information Domain details. 

Specify a DB name for the new infodom. Make a TNS entry with the DB name specified in the 
tnsname.ora file in the oracle server. 

Enter the newly created atomic schema user name, password, and jdbc URL in relevant 
fields. 

Click Next to continue. 

 
      Figure 8: Database details for the new Infodom 
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Step 7-ii 

If the option New Infodom was chosen in the previous panel then the following panel will be 
displayed following the panel 7-i which will seek further information of the following details to 
create infodom. 

Specify the name and description for the new infodom to be created.  

Specify a segment name to be created. 

Note: Segment name should not exceed 10 Characters. 

Also specify the Application server and database server log path for infodom maintenance (to 
be created). 

 
Figure 9: Infodom details for creation of new Infodom 

Note: 

o The OFSAAI user must have a role that is able to perform Add/Modify functions in 
OFSALMA metadata. 

Click Next to continue.  

Step 7-iii 

If the option New Infodom was chosen in the previous panel then the following panel will be 
displayed with the following the panel 7-ii which will display the pre-infodom creation details. 
Check and verify all the details before proceeding to the next step. 
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Figure 10: Pre Infodom Creation Summary 

Click Next to continue creation of information domain. The new information domain is 
created. 

Step 7-iv 

If the option Existing Infodom was chosen in the Step 6 then the following panel will be 
displayed which will prompt to select the infodom from list of infodoms present in the setup, 
enter segment code and enter the application schema’s TNS name. 

Note : 

o Segment name should not exceed 10 Characters. 

 

 
Figure 11: Installation in Progress 

Step 8 

OFSALMA v6.2.0.0.0 data model is packaged as part of OFSALMA v6.2.0.0.0 product 
installer and will be installed as part of the upcoming steps, if required. 

The following screen prompts the user to opt for model upload process through installer. 
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Figure 12: Pre-Setup Information  

Click No if you have uploaded the OFSALMA v6.2.0.0.0 model into information domain prior 
to this installation. 

Click Yes to proceed with the OFSALMA v6.2.0.0.0 model upload process as part of the 
installation. 

If the user selects “Yes”, Step 9 and 10 will be performed. 

Upon selecting “No”, Step 9 to 10 will be skipped. 

Click Next to proceed. 

 

Step 9 

This step is applicable only if you are performing the model upload process as part of the 
solution installation. The following panel prompts the user to choose whether the released 
version of Datamodel or the customized datamodel to be uploaded. 

On selecting Released Data Model option, installer uploads the OFSALMA v6.2.0.0.0 data 
model that is packaged as part of the OFSALMA v6.2.0.0.0 product. 

On selecting Customized Data Model option, installer allows the user to select the data 
model. 

Click Next to proceed. 
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Figure 13: Pre – Setup Information 

Step 10 

If the option Customized Data Model was chosen, the following panel is displayed prompting 
the user to select the customized data model located in the machine. 

Choose the customized datamodel file from the server. 

Note:  

• The data model xml file should be available in the server. 

• In case the installation is being performed on an existing information domain, the data 
model that is planned to be selected in this panel should be merged with the data 
model that was previously uploaded in the information domain. 

In case the installation is being performed on a new information domain, data model that is 
either customized or merged with other data models can be selected in this panel. 

 
         Figure 14: Pre – Setup Information 

Step 11 

The following panel displays pre-model upload details. 

Verify the details before proceeding to the next step. 

Click Next to proceed for model upload. 
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Figure 15: Pre – Model Upload Summary 

This process will take some time depending on the size of the data model and available 
physical memory in the environment. You will not be able to take any further action on the 
screen, until the model upload is complete. Note that this process cannot be rolled back. 

If the model upload fails, then a pop-up message with relevant error and the log file path is 
displayed. 

Review errors and take relevant action. Continue with this step until the model upload is 
successful and the installer takes you to next step. 

Few common errors during model upload are: 

• Insufficient heap memory on the client machine. 

• Possible reason/resolution: The java memory settings in “reveleusstartup.sh” located 
in $FIC_APP_HOME/common/FICServer/bin directory should be increased. 

• Error while getting the Erwin File path. 

• Possible reason/resolution: Restart the FICServer. 

• Error in Upload Operation: “FAILED WHILE SUPER CATEGORY - SUB CATEGORY 
RELATIONS HANDLINGDELETING”. 

• Possible reason/resolution: Incorrect Erwin.xsl file version in 
$FIC_APP_HOME/common/FICServer/conf directory. 

 

Note: 

• Incremental/Sliced model upload might give errors if there are NOT NULL columns 
being added to a table that already has rows or if the columns that are being dropped 
have values. Check the data model changes excel file for any such cases. In such a 
case, take a backup of the table and truncate the table. Insert records back into the 
table with a default value for the NOT NULL column. 

Navigate to the previous screen and proceed with the steps mentioned above. 

Step 12 

The following panel seeks input from the user on whether to create new ETL 
application/source pair or use an existing one. 
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Choose a desired option. 

Click Next to continue 

 
Figure 16: Pre – Setup Information 

Step 13-i 

If the option New application/source pair was chosen then the following panel is displayed 
seeking the application and source name for creation of the same. 

Specify all the details required for application and source creation. 

Click Next to proceed. 

This will create application and source within OFSAAI. Source model will also be generated. 
This process will take some time depending on the number of entities / attributes in the atomic 
schema. This step cannot be rolled back. 

 
Figure 17: Pre – Setup Information 

Note:  

• ETL Source will be created pointing to the information domain (atomic schema) that is 
specified during the installation. 
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Step 13-ii 

If the option “Existing application/source pair” was chosen the following panel will be 
displayed prompting user to select app/source pair from the list of pairs already present. 

Choose the desired ETL application/source pair into which ETL definitions will be deployed. 

Click Next to proceed 

 
Figure 18: Pre – Setup Information 

Step 14 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 
Figure 19: Pre – Install Summary 

Step 15 

This panel displays the installation process. Wait until it completes. 
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Figure 20: Installation is in progress 

Step 16 

The following screen displays the completion of installation of the Oracle Financial Services 
Asset Liability Management Analytics Product Setup. 

Click Done to exit. 

 
Figure 21: Installation Complete 
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Machine B – Product Database Layer 

Step 1 

To begin OFSALMA product installation, execute Setup.sh. 

 
Figure 22: Installation Splash Screen 

Step 2 

Upon invoking the installer, the Introduction screen will display the pre-requisites for 
installation. Ensure that the pre-requisites are satisfied before you proceed. 

 

 
Figure 23: Introduction Screen  

Step 3 

Choose the log mode for this installer. In case, if Debug is selected, the Passwords will be 
printed in the Log File. 

Click Next to proceed. 
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Figure 24: Log Mode Option Screen 

Step 4 

Provide the 9 digit Customer Identification number provided during the OFSAAI installation.  

 
Figure 25: Customer ID Input Screen 

Click Next to continue.
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Step 5 

The Pre Setup Information screen requests for setup information. 

Select the appropriate OFSAAI layer that has been installed on the machine.  

For example, Database Layer. 

 
Figure 26: Pre Setup Information Screen – Choose Layer to Install 

Along with appropriate OFSAAI layer, choose Administrative Reports to configure the 
Administrative Reports application. 

NOTE 

o For a single-tier OFSAAI installation, you must select App Layer, DB Layer and 
Web layer. For a multi-tier OFSAAI installation, select the corresponding layer 
installed on the machine. 

o Incase Admin BI is already configured through the previous product installation; 
the subsequent product installation without Admin BI option may alter the existing 
Admin BI configuration settings. 

Step 6 

The following panel will be displayed which will prompt to select the infodom from list of 
infodoms present in the setup, enter segment code and enter the application schema’s TNS 
name. 

NOTE: 

o Segment code should not exceed 10 characters. 
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Figure 27: Pre Setup Information Screen 

Step 7 

This panel displays all the pre-installation summary. Verify all details and proceed. 

Click Install to proceed. 

 
                 Figure 28: Pre – Install Summary 

Step 8 

This panel displays the installation process. 
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        Figure 29: Installation is in progress 

Step 9 

The following screen displays the completion of installation of the OFSALMA setup. 

Click Done to exit. 

 
           Figure 30: Installation Complete 
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Silent Installation  
Silent installation is achieved via a properties file [Silent.props] that must be updated with 
proper values, before attempting to install using the silent mode. 

How to Install ALMBI in Silent Mode 

To install ALMBI in Silent Mode, follow the below steps: 

1. Create a copy of the Silent.template file present in the installation folder and 
rename the copy as Silent.props. 

2. Edit the file Silent.props and specify the parameters as per the requirements. 

3. From the installer kit, open the file Setup.sh for editing. 

Replace the following text: 

java -classpath ValidatePropsFile.jar 
com.ofs.fsgbu.silentIns.biapps.ClsSilentInstaller 

With: 

java -classpath ValidatePropsFile.jar 
com.ofs.silentIns.fsgbu.biapps.ValidityCheck 

4. Save the Setup.sh file and remove any control M characters, if found. 

5. On the UNIX Command prompt, execute the following command: 

Setup.sh SILENT 

6. Refer to the console log [or the file preinstall.log] for any error messages. 

The following table lists all the properties that need to be specified: 

 

Property Name Description of Property Permissible 
values  

Comments 

LOG_MODE Mode for logging 0 = Debug  
1= General 

Optional; 
Default : 0 

CUSTOMER_ID Customer id specified 
while installing OFSAAI 

Not Applicable MANDATORY 

INSTALL_DB Install database-tier 
components 

0 = No 
1 = Yes 

Default : 0 

INSTALL_APP Install Application-tier 
components be installed 

0 = No 
1 = Yes 

Default : 0 

INFODOM_NAME Information 
Domain(infodom) 

Not Applicable MANDATORY 

SEGMENT_CODE Segment Code Not Applicable MANDATORY 

Segment Code should 
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not exceed 10 
characters 

TABLESPACE Tablespace name Not Applicable MANDATORY 

INFODOM_TYPE New Infodom or Existing 
Infodom 

0 = New 
1 = Existing 

# Specify Infodom Type 

Mandatory if this an 
App Layer Installation 
and option selected for 
INSTALL_APP=1 

APPL_TNS TNS Name of the 
Infodom database 

Not Applicable MANDATORY 

APPL_USER User-id of the Database 
Schema for new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_PWD Password  of the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APPL_URL JDBC Connection String 
of the Database Schema 
for new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

RAC_STATUS whether the Database 
Schema for new Infodom 
is a RAC database 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 
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INFODOM_DESC Description for the 
Database Schema for 
new Infodom 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

APALM 
P_LOG_PATH= 

Infodom Maintenance log 
path (to be created) for 
the new Infodom for app 
layer. 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

DBFTP_LOG_PAT
H 

Infodom Maintenance log 
path (to be created) for 
the new Infodom for 
DBLayer. 

Not Applicable # Mandatory if this an 
App Layer Installation 
and want to create a 
new infodom 

# Option selected for 
INSTALL_APP=1 and 
INFODOM_TYPE=0 

UPLOAD_MODEL whether you want to 
perform Model Upload 

0 = No 
1 = yes 

Mandatory if 
INSTALL_APP=1 

MODEL_TYPE Released datamodel or 
Customized datamodel 

0 = released 
1 = customized 

Mandatory if 
INSTALL_APP=1 

DATAMODEL the path for the 
customized datamodel 

Not Applicable # Mandatory only in the 
case  of uploading the 
customized datamodel 

# Option selected for 
MODEL_TYPE=1 

DM_DIRECTORY the file name for the 
customized datamodel 

Not Applicable # Mandatory only in the 
case  of uploading the 
customized datamodel 

# Option selected for 
MODEL_TYPE=1 

ETL_APP_NAME The ETL application 
name 

Not Applicable # Mandatory if this an 
App Layer installation 

# Option selected for 
INSTALL_APP=1 
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ETL_SRC_NAME The ETL Source into 
which the Table-2-Table 
ETL definitions on staging 
tables will be deployed. 

Not Applicable This Source must be 
mapped to the above 
ETL Application 

ETL_APPSRC_TY
PE 

Create new ETL App/Src 
pair or use an existing 
one 

0 = New 
1 = Existing 

# Mandatory if this an 
App Layer installation 

# Option selected for 
INSTALL_APP=1 

# 0 = If you want to 
create a new ETL 
app/src pair 

# 1 = If you want to use 
an existing pair 

ETL_APP_DESC Give description for the 
ETL App 

Not Applicable # Mandatory if you want 
to create new ETL 
app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=
0 

ETL_SRC_DESC Give description for the 
ETL Src 

Not Applicable # Mandatory if you want 
to create new ETL 
app/src pair 

# Option selected for 
ETL_APPSRC_TYPE=
0 
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Post Installation Activities 
Oracle Financial Services Analytical Applications Infrastructure Server Memory 
Configuration 

The Oracle Financial Services Analytical Applications Infrastructure Application Server is 
started using reveleusstartup.sh file. This file can be edited for customizing memory settings 
and garbage collector settings depending on the available hardware configuration. Raise a 
Service Request (SR) via support.oracle.com if you have any queries related to EPM 
applications. 

Once the installation of OFSALMA is completed, you must perform the following steps. 

• Check the Log file (The path and file name specified in the log4j.xml). You can ignore 
the following errors in the log file: 

o Error: ORA-02260: table can have only one primary key. 

o Error: ORA-00955: name is already used by an existing object. 

o Error: ORA-00001: unique constraint (<<UNIQUE KEY NAME>>) violated.  

o Error: ORA-02275: such a referential constraint already exists in the table. 

o Error: ORA-01430: column being added already exists in table. 

o Error: ORA-02303: cannot drop or replace a type with type or table 
dependents 

 

26 
 

http://support.oracle.com/


 

Oracle Financial Services Asset Liability Management 
Analytics Configuration 

1. Make sure Oracle Business Intelligence (Version 11.1.1.7.0) installation is completed 

with the patch 16556157 and is available. 

2. Set the <Oracle BI Instance Home> directory. 

For example, /u01/OBIEE11G/instances/instance1. 

3. Start Weblogic AdminServer. 

a. Set the < BI Domain Home> directory.  

For Example, /u01/OBIEE11G/user_projects/domains/bifoundation_domain. 

b. Navigate to < BI Domain Home >/bin and run nohup ./startWebLogic.sh &. 

c. Bringing up this service may take a few minutes depending on your 

environment. Check the logs using the command tail –f nohup.out. 
4. Start Node Manager. 

a. Set the < WebLogic Server Home > directory>. 

For example, /u01/OBIEE11G/wlserver_10.3. 

b. Navigate to <WebLogic Server Home>/server/bin and execute the command 

nohup ./startNodeManager.sh &. 

5. Start Weblogic Managed Server(bi_server1). 

a. Login onto http://localhost:7001/console using your Administrator credentials 

created during platform install (Replace the hostname based on your setup). 

b. Under Environment, click Servers link. 

 

      
 

The bi_server1 line should show as shutdown state at this point. 
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c.  Click Control tab. 
 

 
 

d. Select the bi_server1 line by clicking on the left tick box. 

e. Click Start button at the top of the list and confirm starting this service. 

 
 

f. State will update to “RUNNING” mode after a few minutes.  
 

6. Start OBIEE services and login  
 

a. Starting services From EM screen  

i. Login to the EM administration screen using the URL: 

http://localhost:7001/em (Replace the hostname and port number 

based on your setup). Use the login you created in BIEE installation 

to log in. 

ii. Expand 'Business Intelligence' node on the left and choose 

Coreapplication.  

 
 

iii. Click Overview Tab. 
 

28 
 



 

  
 

iv. Click Restart (or Start) under the Manage System section. 

v. Click Yes on dialog box to confirm the move. Wait for message that 

confirms successful restart. 

b. If starting using EM is not successful and complaining about OPMNCTL not 

up, follow starting process with OPMNCTL. 

i. Open a command prompt, navigate to <Oracle BI Instance 

Home>/bin. 

ii. Run ./opmnctl status, this will show you status of all the OBIEE core 

services  

iii. run ./opmnctl startall or ./opmnctl stopall depending on your need. 

7. Deploy RPD and webcat file(s). 

a. Navigate to folder $FIC_HOME/ALMBI/RPD_WEBCATALOG/ which contains 

both ALMBI.rpd and archived ALMBI.catalog (contains the shared folder of 

ALMBI application).Copy both the files to a local folder. 

b. Login to  

I. OBIEE – Enterprise Manager URL (http://<ip address>:<port>/em). 

II. Click on coreapplication from ‘Business Intelligence’ tab on left hand 

side. 

III. Under ‘coreapplication’, select the tab ‘Deployment’ and click ‘Lock and 

Edit Configuration’ button located below title ‘coreapplication’. The below 

screen is displayed. 
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IV. RPD Deployment: 

1. Select Browse button available under Upload BI Server 
Repository section and select ALMBI.rpd file from the local 

folder. Enter Repository password ‘Administrator1’. 

V. Web catalog Deployment: 

1. Create a new webcatalog folder for ALM BI application through 

Enterprise Manager of OBIEE. 

2. Set the Catalog Location available under ‘BI Presentation 

Catalog’ like: 

“$ORACLE_INSTANCE/bifoundation/OracleBIPresentationServic

esComponent/$COMPONENT_NAME/catalog/ALMBI”. 

3. Click Apply and then click Activate changes. A pop up will be 

shown after successful activation. 

 
 

4. Click Close and switch to Capacity management tab. 

5. Restart the presentation services. Under the System 
Components Availability, select Presentation Services and 

click on Restart Selected option. 

 
 

VI. Once the Presentation Service is restarted, it will give the pop up for 
successful restart. Click Close. 
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VII. Verify that new folder structure is created in the system. It can be found 

under path : 

 <Oracle BI Instance Home> 

\bifoundation\OracleBIPresentationServicesComponent\coreapplication_

obips1\catalog\ALMBI 

VIII. This ‘ALMBI’ folder will be having a root folder which in turn contains 

three folders named ‘shared’, ‘system’ and ‘users’. 

 
 

c. Open the Catalog Manager 

a. Navigate to File menu and open the catalog online (File->Open catalog) by 

giving the necessary credentials based on your setup (Type - (online), URL - 

(http://<ipaddress>:<port>/analytics/saw.dll). 

b. Once the catalog is opened, it will display a folder structure on left hand side. 

Select the root folder in the LHS tree structure. 

c. Go to ‘File’ menu and select ‘Unarchive’. It will ask for the path for a file. 

d. Browse the path of the archived catalog file saved in your local folder using 

the ‘Browse’ button in the pop up. Click ‘OK’. 

e. The catalog will be unarchived in specified location. A pop up for successful 

operation will be shown. Restart the presentation services once again. 

d. Open the analytics OBIEE URL- (http://<ipaddress>:<port>/analytics) Login with 

credentials based on your setup, and verify that catalog is available. 

8. Configure tnsnames.ora. 

a. Open "tnsnames.ora" file under the folder - <Oracle Home>/network/admin. 

b. Make sure an entry is made in the tnsnames.ora to connect to atomic 

schema of OFSAA application. 

c. Save the tnsnames.ora. 

9. Configure ODBC data source to connect to Oracle BI Server. 

a. Go To Control Panel>Administrative Tools>Data Sources (ODBC). 

b. Select the ‘System DSN’ tab and click ‘Add’ Button. 

c. Select a driver specific to (Oracle BI Server 11g) and click ‘Finish’ Button. 

d. Enter ‘Name’ and ‘Server’ details (Specify the Host Name or IP Address of 

the BI Server and click ‘Next’). 

e. Enter Oracle BI Server login id and password (Enter User Name and 

Password created at the time of OBIEE installation). Click ‘Next’. 

31 
 



 

f. Click ‘Finish’. 

10. Modify connection pool and set the properties.  

a. Open the OBI Administration tool. 

b. Select Start > Programs > Oracle Business Intelligence > BI Administration. 

c. Select File > Open > Online and select ‘ALMBI.rpd’ file. 

d. In the Open dialog box, select and open ‘ALMBI.rpd’ file. 

e. Enter Repository password as ‘Administrator’. 

f. In the "Physical" layer, double-click the Connect Pool: “ALMBI” to open its 

properties. 

g. In the ‘General’ tab, edit / check the following entries: 

• Call Interface: (OCI 10g/11g).  

• Data source name: <tnsnames.ora entry created in the step 8.b 

connecting to OFSAA atomic schema>.  

• User name: <enter atomic db user name>.  

• Password: <enter atomic db user password>.  

• Confirm password and Click 'OK' to close the window. 

• Similarly, configure the connection pools for ‘ALMBITRANS’ and 

’ALMBI_INIT_BLOCK’. 

• Click 'Save' to save the RPD file.  

h. Click 'No' for the Global Consistency Message.  

i. Close the RPD file (File / Exit).  

11. Login into OFSALMA Application using the URL: 

http://localhost:9704/analytics.(Replace the port number based on your setup). 

12. Steps to configure BI publisher Data Source. 

a. Login into OFSALMA Application. 

b. Navigate to Administration’ >BI Publisher > Manage BI Publisher. 

c. Click JDBC Connection from Data sources. 

d. Click Add Data Source button. 

e. Enter the data source name as ‘LRM’ 

f. Add Database details in Connection string, that is host name (IP address), 

port number, and Sid  

g. Enter the username (schema name) and password. 

h. Click Test Connection. 

i. Ensure that the connection successfully established. Click Apply button. 
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13. Execute the following steps to implement the Writeback feature: 

a. Add the tag <LightWriteback>true</LightWriteback> in between 

<ServerInstance> </ServerInstance> in the file instanceconfig.xml 

file. 

For example: 
<ServerInstance>  

<LightWriteback>true</LightWriteback> 

…………………….. 

……………………… 

</ServerInstance> 

b. Copy the writeback.xml file available at 

$FIC_HOME/ALMBI/RPD_WEBCATALOG/ location to the below mentioned 

obiee server folders. If customMessages folder is not present, create the 

folder manually. 

Path1: <BI Oracle Home>/bifoundation/web/msgdb/customMessages/ 

For example: 

/scratch/oracle/obiee111171/Oracle_BI1/bifoundation/web/msgdb/customMe

ssages/ 

Path2: <Instance 

Home>/bifoundation/OracleBIPresentationServicesComponent/coreapplicatio

n_obips1/analyticsRes 

For example: 

/scratch/oracle/obiee111171/instances/instance1/bifoundation/OracleBIPrese

ntationServicesComponent/coreapplication_obips1/analyticsRes/customMes

sages/ 

c. Restart OBIEE Server. 

d. Login to OBIEE Analytics and navigate to Administration section on the right 

top corner. 

e. Click Manage Privileges and scroll down to Writeback. 

f. Grant Writeback to Database privilege to Authenticated User and BI 

Administrator roles. 
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Trouble shooting 
 

Problem: After logging into OFSALMA Application, if end user experiences an error as 
“Exceeded configured maximum number of allowed output prompts, sections, rows, or 
columns” while accessing reports. 

Solution:  

1. Bring down OBIEE Presentation services. 

2. Locate and take a back up of the file ’Instanceconfig.xml’ in following folder structure 

<Oracle BI Instance 

Home>\config\OracleBIPresentationServicesComponent\coreapplication_obips1 

3. Edit the file. Locate the tab ‘<view>’ which in turn contains ‘<pivot>’ tab in 

instanceconfig.xml. 

4. Paste the following lines in between ‘<pivot>’ and ‘</pivot>’ tab. 
<MaxVisibleColumns>3000</MaxVisibleColumns> 

<MaxVisiblePages>10000</MaxVisiblePages> 

<MaxVisibleRows>50000</MaxVisibleRows> 

<MaxVisibleSections>250</MaxVisibleSections> 

<DefaultRowsDisplayed>30</DefaultRowsDisplayed> 

5. Save the file and restart the presentation services. 

 
Problem: Batch definitions not coming up in the Batch Execution screen. 

Solution: Check the Group privileges and make sure the logged in user is mapped to the 

'ADMIN' Group. 

34 
 



 

OBIEE Installation and Configuration Guide Link  
You can refer to the OBIEE installation and configuration guide from the following location: 

• http://www.oracle.com/technology/documentation/bi_ee.html
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